
About LOAS

About LOAS

LOAS is software designed to analyze radio-telemtry data. You may evaluate LOAS for a fixed time period
determined by the software. After the evaluation time has expired, you may either purchase an access code to
license your copy of LOAS or you must remove the software from your computer. Use the standard Windows
'Add/Remove Programs' option available from the Windows Control Panel.

Web site address is http://www.ecostats.com

Passwords

Passwords are provided only to registered users. You must enter your user identification number (User ID)
and Password as described in the registration help section.

If you do not have a valid User ID and Password you may get then online by going to the ESS online order
system. Your User ID and Password will be given to you at the time of purchase. If you experience problems
with your password or online purchase e-mail mail@ecostats.com.
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Custom Functions

If you need custom functions or attributes added, all Ecological Software Solutions product software can be
adapted to your needs. Please e-mail Ecological Software Solutions

Custom functions can be added in a variety of formats. Please see the ESS design services web site for more
information.

Getting Started

Open Data File

Open Overlay File
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Menu: Files -> Open Data File

LOAS opens several basic data file types including database files, Excel files, and text files. Overlays of shape
or geographical features can also be opened and accessed by LOAS.

Database files may either be a dBASE (*.dbf), or Microsoft® Access (*.mdb -- requires use of the visual SQL
generator) file format. Text files should be stored in either comma (often with the *.csv or *.txt extension) or tab
separated values (usually *.txt). Any of these text file formats may be created from most common database
and spreadsheet programs. If a comma or tab is not found in text file data record, the each record in the text file
will be parsed by spaces. This is an inconsistent method of data storage and LOAS uses it only as a legacy
format. All new text files should be either tab or comma delineated.

When a file is opened, LOAS will present a variable definition screen where at least the fields that represent
data point locations, "X,Y", bearing field, and the group variables (if any) must be defined. Once these fields are
defined all files with the same point location fields will open without any further redefinition.

Also see: Redefine Variables, Database Links

Open Overlay File

Open Overlay File

Menu: File > Open File File > Open Overlay File

LOAS currently supports and imports ArcView® shape files (*.shp), MapInfo (*.mpf), and Data Interchange
(*.dxf) formats.

Graphical results from LOAS also be exported to an ArcView® compatible shape file format. Previous results
can, therefore, be imported later as a coverage for comparison without having to re-analyze the data.

n overlay file can be opened in two ways. Either directly from either the menu item "File/Open Files" or
"File/Open Overlay Files". Two methods of opening overlays are provided because (1) data files may be of the
type "Point" and (2) it is an easy and convenient way to open all files through a common interface.

However, the standard open file option will only go to the specific folder designated for data files and display
files corresponding to the default file extension. This can be a problem with ArcView® shape files when
Windows® has registered file extensions turned off (the Windows® default state) since the supporting database
for a shape file will have the same name as the shape file (only the un-displayed file extension is different).
Thus the database file may appear to be the shape file to open. This will happen if the default file extension is
set to "dBASE (*.dbf). By opening overlays with the "File/Open Overlay Files" menu item this can be avoided.

Close File

Close Files
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Menu: File > Close File

The close file dialog box allows for closing of all files that were opened or calculated in LOAS. Closing a file
deletes them from local memory but not from a disk drive. If calculated results were not first saved to a disk,
then they will be permanently deleted. You can save individual files as data or GIS formats. You can also use
the Save Workspace feature to save all open files and reopen them later with the open workspace function

Clicking on the 'Close Files' button will close the files. Click on the 'Finished' button to exit this window.

Create New Database File

Create New Data File

Menu: File > New Data File

LOAS has a simple utility to create new data files. Options exist to either create a new text file or a database
format. Once a data file has been created, it can be treated as any data file created in another application. Data
can be entered, added, deleted, and all analysis run once data is added.

If a new data file is created each field must be defined as a type: character, numeric, boolean (true/false), date,
and date-time field may be available, depending on the file type selected.

If the box to the left of the field name is checked the field will be added to the new data file. To not add a field to
the new data file, either delete the field or just un-check the field name, which preserves the field for later use is
desired.

Database Links

Linking Files

Database tables can be linked in two ways. Either by using the Visual SQL Generator that allows for multiple
links across many database tables (called a many-to-many link), or by a single parent to child link (called a
one-to-one link) using the database link form (Figure 1). This one-to-one linking will also work with text and
Excel files.

Figure 1. Database Links Form
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To use the single database link form, the parent database is either selected or provided by default by the
software. Then you browse for or type in the full path and name of the database table you will link to (Note:
Microsoft Access tables can only be linked by the Visual SQL Generator).

Once the parent and child tables are selected, click on one field form each table to act as the linking field. The
fields do not have to have the same name but it is less confusing if you name the linking fields the same in
each table. Click on the Link button to create the link between the tables.

When linked databases are used it is usually necessary to either apply an index on the fields or perform a sort
because linked databases will by default sort on the linked field. Therefore, if this is not the normal order of the
data, it is necessary to force the data to be retrieved in a more normal order using a sort.

Printing

Printing

Menu: File > Page Setup / Print

Currently, printing is for the graphics canvas and charts only. Data and output log information can be copied
and pasted into a spreadsheet, wordprocessor, or database program for printing.

Selecting Files

Selecting Files

Most forms that process data display a list view of the data file names, point or shape count, and the file type.
Also displayed are the file's display attributes. You may click on any column header to short the columns by
type. Left click on the check box to the left of each data file that you wish to process in an analysis. Right click to
check or un-check all the files.

Data Grid

Data Formats

Database

Database

Databases and other files used by LOAS must consist of row and columns (also known as fields) of data. The
records represent the individual data in any one row and field combination. Each field require a unique name in
the database.

Column Formated Data

Column Formated Data
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Column formatted data have all the receiver and bearing locations under one field each. Data in Column
format is easier to read and can take up less file space if bearing group size varies (biangulations,
triangulations, > 3 bearings, etc). Databases can also be linked with bearing data in one file, and receiver
locations in another file.

Example format:

Station_X   Station_Y   Bearing   Group
4151414      514140       189       1
4151131      513910       91        1
4151978      514687       310       1
4151414      514140       172       2
4151131      513910       68        2
4151978      514687       275       2
etc.....

 

Saving Data

Export Overlays

Export Overlays

Menu: Overlays > Export Overlays

Overlays are expoted to ESRI shapefile formats, Windows enhanced metafile format (EMF) (use the graphic
output option), and to a limited extent DXF file format. In addition, Shape Viewer uses the Windows to copy and
paste the canvas into any word processor or drawing program that accepts EMF formats.

When a file is exported as a shapefile, a database file is also created. You must accept the structure of the
database file that will be created with the shapefile. A New Database window will appear displaying the fields to
be exported and their types. Make desired adjustments or just press the "Accept" button to export the default
fields. Any existing data corresponding to the original displayed fields will be exported with the shape file. New
fields created at this point will contain no data. But data can be entered into these fields at any later time.

Save File

Save File

Menu: File > Save

LOAS saves files in a variety of formats depending on the data to be saved.

Data files are saved as database or text files
Graphics are saved as Windows® Metafiles, Bitmaps and JPEG files, ArcView® shape files or Data
Interchange Format (*.dxf) files.

The graphic canvas and charts can also be saved to the Windows® clipboard to be copied and pasted into
other applications, such as word processors.
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To save a data file, first select the file as the active spreadsheet tab. Select "Save Data" from the main menu.
Select "Telemetry Data" as the file type to save. You will be presented with a New Database dialog window.
Select the fields you want to export and continue to save the file.

Also see: Export Overlays

Save the Work Space

Save the Work Space

Menu: File > Save Work Space

If this menu item is clicked, then any currently opened shapes will be available for reopening at once by clicking
on the "open last work space" menu item. Files that do not already have disk based file names will be assigned
a file name by LOAS and saved for later reopening.

Save Bitmap

Save Bitmap

Saving the canvas as a bitmap is done from the export overlay menu option. You can save the canvas image as
either a bitmap, JPEG or Windows Metafile format.

The size of your bitmap in pixels can be selected before you save it. The small the width and height, the smaller
will be the resulting file size.

Save JPEG

Save JPEG

Saving the canvas as a JPEG file format is done from the export overlay menu option. You can save the canvas
image as either a bitmap, JPEG or Windows Metafile format.

You can control many features of your JPEG file including the resolution, grayscale and degree of detail in the
output. The greater the detail the more sharp the image will appear, but the file size will also be much larger.
For images intended for the Internet, a smaller file size is usually better.

Preferences

User Preferences

The User Preferences window is used to set up user defaults. For more information on selected items, chose
from the following items:

Files
Spreadsheet
Output
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The most significant user preference is to set the standard folder where files and overlays are stored.

Default settings will not be changed unless you select the "Apply" button before closing the window.

User Preferences - Files

User Preferences - Files

This file window is used to select what folders will be used as the default folder when opening files. This will
reduce searching your hard drive for these files each time you wish to analyze a data set.

You may select folder options for your dataset files as well as GIS overlay files and your workspace folder.

See also: User Preferences

 

User Preferences - Output

User Preferences - Output

This output window is used to set basic numeric and font outputs for the spreadsheets.

Area units can be set here and will determine how areas are calculated.

Global precision (number of values after a decimal point) for any numeric cell is also set here. Alternatively, the
format and cell precision of individual columns can be set by right clicking on the cell in the spreadsheet and
selecting the format option.

See also: User Preferences

 

Preferences - Spreadsheet

User Preferences - Spreadsheet

This spreadsheet window is used to set basic update functions for the spreadsheets.

Blink Canvas on Mouse Click If selected, then a click in the spreadsheet cell will blink the point on the
canvas. You can also get this function in another way by right clicking the sheet and selecting to blink the
shape.
Replot the canvas on record update If selected, then when a value in the defined station fields
changes by editing the sheet the canvas will alter the point shape location as required once the record is
exited.
Output only successful results If selected, then if the bearing did not generate a result, then its data
will not be recorded in the result sheet.

 

See also: User Preferences

1/1/2005 Page 7



 

Calculating Locations

Group Variables

To process multiple bearings in a column formatted file one needs to assign group variables that define
unique bearing sets in the file.

For example, imagine a data file containing multiple bearings taken on many different radio-tagged animals.
Also in the file are fields representing the dates the bearings were taken and the frequency of the transmitter on
each animal. By selecting the date (DATE) and then the frequency (FREQ) as group variables LOAS will
process those records that have the same date and frequency values recorded in these fields as a single
bearing set. LOAS uses the fields selected in a hierarchal manner. That is, as in this example date was
selected first,. LOAS will compare dates first before it compares frequency. All the data, if carefully laid out in
the original file, can then be quickly analyzed by creating group variable set.

If a file has more than one bearing taken for any one animal in a day it can be seen that only using date and
frequency would not be sufficient. In this case an axillary variable in the file should be constructed that
represents the bearing group number taken throughout the day.

Redefining Variables

At any time the fields in a file assigned to the variables associated with location data (X,Y) can be changed or
redefined. To alter any of these fields, first select the file from the provided legend, then change the desired
field references.

After fields have been changed, LOAS will repaint the graphic canvas to account for any changes in location
information. However, these changes will occur only for the current file locations. Any previously calculated
contours created from this data will not change.

Calculate Locations

To analyze bearing data the user should first consider the following:

select the estimator used to calculate the estimated location and error ellipse
decide what values to include in the results output
select point and line styles used to draw the results graphically
define any labels to be displayed on the graphic canvas
define any filters if desired.

 

Once this is done, simply place the mouse cursor on the fixed column (far left column displaying the record
numbers) and either drag the mouse to highlight the desired rows to analyze or click on any set of rows while
holding down the control (Ctrl) key. Then select the "calculate locations" option from the Calculations menu
item or click on the calculate bearings toolbar icon.
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Output Variables

Output Variables

Selected variables on this form will be sent to the results spreadsheet after the data is analyzed. Some values
may not correspond to actual data output. For instance, unless the maximum likelihood estimator or an M
estimator is selected as the estimator used to locate the signal source from the bearing data, no ellipse results
will be generated.

The standard output variables that may be included in the results spreadsheet are:

Bearing Data

This includes each of the receiver locations and their bearings.

Bearing Count : Shows the total number of bearing that were actually used to estimate the location
(minus bearings that were thrown out by LOAS as being duplicates or non-intersecting).
Angular Error : The angular error between the bearing and the estimated location.
Angular Distance : Distance from the estimated location perpendicular to the bearing line (e.g.
Sin(Angular Error) * Distance to estimated location from the receiver).
Receiver Distance : Distance from the estimated location to the receivers
Inter-bearing Angle : The matrix of angles between all bearings.
Estimated Locations : The X and Y coordinates of the estimated location.
Variance/Covariance : X and Y variance and covariance for the estimated location if a maximum
likelihood or M estimator was used.
Ellipse Area : Area of the error ellipse.
Ellipse Axes : Ellipse major and minor axes lengths.
Error Polygon : Gives the error area for intersecting biangulations if a constant bearing standard
deviation error is given, and the simple (no bearing standard deviation involved) polygon area from
intersecting bearings for triangulations. Greater than 3 bearings will provide no output.
Signal Location :The X and Y coordinates of the actual signal location if telemetry system tests are
being performed and the true signal location is know and set as a file variable.
Error Angle : The angle between the actual signal location and the bearing lines as measured from
each receiver location.
Error Distance : The distance between the actual signal location and the estimated location.
Signal in Ellipse : True or False value if the actual signal location was located in the error ellipse
computed for the estimated location. Used for testing telemetry systems.

 

In addition to standard output, the results sheet can also include field values from the original data file by
checking the box nex to the field name. This is useful when such significant information as date, transmitter ID
or frequency is desired in the output file to more clearly identify the results.

Also see : Estimators

Error Log

The error log is used to report any errors that LOAS encountered during an calculation of bearing data. You
should typically review this after any calculation as many error are silent and do not alert you to their existance
other than being written to the error log.

How Many Bearings to Use?
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The question of how many bearings to use to locate a signal is a debatable topic. Generally, the decision
should be based on an intimate understanding of the limitations inherent in both the telemetry equipment and
the study site. That is, one can clearly not get the optimal 120 degrees between bearings for a triangulation if
the study is done on a near shore oceanic species, from land based receivers, along a straight coastline. If the
transmitters are small, the distance the signal can be received may be short, and might even preclude an
optimal angle of 90 degrees for a biangulation.

However, there are a few general rules to consider when deciding on what may be optimal.

More bearing are always better, but there is a cost benefit ratio involved. With triangulations try to have an
inter-bearing angle of 120 degrees, and for biangulations an inter-bearing angle of about 90 degrees.
Generally, if biangulations are all close to 90 degrees then the average error in the location of the
estimate will be about the same as for triangulations. However, the variance of the biangulation error will
also usually be significantly greater. That is, some estimates from biangulations will always be further
from the actual signal source than if a triangulation was used. The more the biangulations vary from 90
degrees the more variation the data will have.

1.

The closer you get to the signal the better. This is an issue of bearing error. If the bearing error for a
bearing is 3 degrees, then the distance to the actual signal source from bearing line is about 5 meters at
100 meters from the signal source (equation = sin(3)*100) and about 26 meters at 500 meters from the
signal source (equation = sin(3)*500).

2.

Using many bearings allows one to use the maximum likelihood estimator (>3 bearings) and M (>5
bearings) estimators. From these estimators one can create error ellipses to investigate location
accuracy.

3.

If the study site is in very hilly or rough terrain, then consider not even using estimation software methods,
until the accuracy of the technique has been established for the study site.

4.

Also see: Estimators

Convert Ellipse Matrix

The convert ellipse matrix function allows for the import of bearing data from other radio telemetry software
may have been used to analyze your data. This utility allows for conversion of a text file containing an ellipse
variance/covariance matrix into a shape file of ellipses usable by LOAS and other software.

All fields shown must be selected with the exception of 'Receiver N' which is the number receivers that defined
the ellipse. Note that this is not necessarily the same as the number of bearing taken for the location as some
bearings might have failed.

LOAS will create a database (*.dbf) out of the original text file. Ellipse matrix values that fail (e.g. have no area)
will not be included in the output shape file or database.

To have LOAS display the results immediately check the 'Open as overlay' check box. Otherwise LOAS will
only create the new files and not use them. To alter the ellipse parameters for this output file click on the
Ellipse button.

Estimators

Select Estimators

You use the select estimators window to select the location estimator you wish to use to estimate your
locations from your bearing data. LOAS uses seven different estimators to determine the location of a signal
from bearing data.
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Maximum Likelihood Estimator
Huber Estimator and Andrews Estimator
Best Biangulation
Arithmetic Mean
Geometric Mean
Harmonic Mean

These different methods vary in complexity and resulting accuracy. However, no single method is superior for
all possible circumstances and the telemetry system employed should be tested and the data verified to
determine the best option to use (for example, see Garrott and White, 1990). Tests of the telemetry system
used can also be performed in LOAS. For more information, see the simulations component of LOAS.

Selection of a proper estimator for any particular data set is in many ways both a science and an art form. The
selection of the estimator used will be in part determined by the number and quality of the bearings, the desired
output, and the level of accuracy.

The Maximum Likelihood Estimator (MLE), Huber or Andrew's estimator will attempt to calculate a location
estimate even if bearings do not cross. There may be some question as to the accuracy of location estimates
without bearing intersections, especially with the MLE estimator, but this estimate can be attempted, if desired,
by checking "Use Bearings With No Intersections" box.

If the Maximum Likelihood Estimator, Huber or Andrew's estimator is used, then by entering a value for the
'Standard Deviation' LOAS will use this value to calculate the estimated location with these methods instead of
estimating it from the data. If a biangulation only is used, then setting a fixed bearing standard deviation will
provide an error polygon if the error polygon output variable is selected.

If there is a constant bias in the bearing data (such as a declination offset) entering a value here will result in
LOAS correcting each bearing value accordingly before it analyzes the data. There are also options to add
corrections for compas declinations (positive or negative value will depend on your geographical area).

 

Error Ellipses

Error Ellipses are used to estimate the accuracy of a resulting estimate using either the Maximum Likelihood
Estimator or an M Estimator. The anticipated accuracy of the ellipse, which is defined as the number of times
the actual signal source would be contained within the ellipse, is dependent on the type of confidence
distribution used to calculate the ellipse. LOAS provides three different distributions to calculate a confidence
ellipse. The different methods are provided for the most flexible comparability to other software programs.

Most current software programs only use the Chi Squared method of calculating the error ellipse. This method
is not the best choice as the resulting ellipse will only represent a true accuracy of about 45-85% when the
anticipated accuracy was set to 95%. The'F' and the 'Adjusted F' distribution will provide the greatest match
between actual accuracy and anticipated accuracy (usually providing a true accuracy of greater than 90%
when the anticipated accuracy was 95%). The adjusted F represents an unbiased estimator and is the
preferred method to use. However, the ellipse area will be larger using the 'F' and the 'Adjusted F' distributions
as opposed to the Chi Squared distribution, and some may find this objectionable. Readjusting the desired
confidence somewhere in the range of 45-85% will provide similar ellipse sizes as using a 95% confidence
interval with the Chi Squared distribution.

As long as one is aware of the actual accuracy obtained by using the Chi Squared distribution, and the error
ellipse is only used as one relative component in determining the estimated accuracy of a location, the choice
of which distribution to use remains flexible.
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On Estimate Error

The Maximum Likelihood and M Estimators are iterative processes that may fail for any number of reasons
including incorrectly entered data and bias bearings. Therefore, the On Estimate Error tab allows for a fallback
method of estimation to be employed when the iteration methods fail.

See the respective help on each of the following alternatives: Best Biangulation, Arithmetic Mean, Geometric
Mean, or Harmonic Mean.

Alternatively, one can select to "do nothing" and allow no estimate to be calculated for a failed iteration.

Also see: Estimators

Estimation Methods

Maximum Likelihood Estimator

The Maximum Likelihood Estimator (MLE) described by Lenth (1981) uses an iterative algorithm that
essentially tries to find the minimum angular error between the observed set of the bearings and the signal's
estimated location. Hence it finds the most likely estimate for a location given a set of bearings. In this way MLE
works much like linear regression, which tries to minimize the residual values between data points to determine
the best linear fitted line. The benefit of using a maximum likelihood estimator is that it also provides a way
describing the variability of the estimated location, and hence a form of statistical accuracy may be applied to
this estimate in the form of an error ellipse. However, the MLE assumes the data is &#145;clean'; that is, there
are no outliers (wayward bearings) in the data. Such bearing outliers can be found both visually from the
resulting graphical output, or by selecting the angular bearing option in the output variables form. If bearing
data has outliers, the MLE should not be used.

Because the MLE is determined in a recursive manner, two features must be set to limit the recursion. These
are the desired accuracy of the estimate and the number of iterations that should be attempted before the
process is terminated and deemed to have failed. Recursion will continue until either the defined level of
accuracy is achieved (a successful estimate), or the number of iterations is surpassed (an unsuccessful
estimate).

The Maximum Likelihood Estimator will attempt to calculate a location estimate even if bearings do not cross.
There may be some question as to the accuracy of location estimates without bearing intersections, especially
with the MLE estimator, but this estimate can be attempted, if desired, by checking "Use Bearings With No
Intersections" box.

On may also select the fallback method of location estimation to use when an iteration fails.

Also see: Estimators

M Estimators

The M Estimators include the Huber and Andrews methods. These are a advanced class of the Maximum
Likelihood Estimator (MLE) in that the M Estimators weight individual bearings depending on their relative
contribution to the estimated location. That is, the M Estimators will give less weight to outliers in the bearing
data and hence may be used when such 'unclean' data is present. However, then M Estimators are limited in

1/1/2005 Page 12



that they typically require 5 or more unique bearings to properly calculate the estimate. This is because with 3
or 4 bearings it is possible for 2 of those bearings to alternately exchange weighted status indefinitely, resulting
in the algorithm never converging to a solution.

Like the MLE, the M Estimators use a recursive algorithm to calculate the estimated location. Two features
must be set to limit the recursion, and one constant is used to 'tune' the M Estimator. The values that limit the
recursion are the desired accuracy of the estimate and the number of iterations that should be attempted
before the process is terminated and deemed to have failed. Recursion will continue until either the defined
level of accuracy is achieved (a successful estimate), or the number of iterations is surpassed (an unsuccessful
estimate). Typically a tuning constant of 1.5 is used for the M Estimators provided with LOAS. This value should
not be varied unless one is very familiar with the M Estimator equation being used (see Lenth 1981 and 1981b).

The Huber or Andrew's estimator will attempt to calculate a location estimate even if bearings do not cross.
There may be some question as to the accuracy of location estimates without bearing intersections, especially
with the MLE estimator, but this estimate can be attempted, if desired, by checking "Use Bearings With No
Intersections" box. Because the M-estimators will weight bearing data, leaving this option unchecked would
typically have little affect on the location estimate.

On may also select the fallback method of location estimation to use when an iteration fails.

Also see: Estimators

Best Biangulation

Biangulations are calculated automatically by LOAS when there are only 2 bearings available. However, there
are times when >2 bearings are present but only a biangulation calculation is desired (See How Many Bearings
To Use? for a discussion on optimal bearing number). In this case, the best biangulation may be used to
estimate locations were > 2 bearing are present.

The Best Biangulation method will calculate all intra-bearing angles and select the bearings whose angle is
closest to 90 degrees; that is defined here as the "best" angle.

Also see: Estimators

Arithmetic Mean

The Arithmetic Mean sums up all coordinate points and takes the average using the following formula:

Equation = S xi / n. Where xi are the bearing intersection coordinates from 1 to n.

This is the ‘classic' method of locating the signal source, and still commonly used when other methods fail.
However, the arithmetic mean is sensitive to extreme intersection point locations within the cluster. That is, if
one intersection point is very distant (outlier bearing) from the other two intersections in a triangulation, then the
estimated location may be greatly displaced.

Also see: Estimators

Geometric Mean

The geometric mean gives the geometric average of the coordinate points using the following formula:

Equation = 1/n S log xi. Where xi are the bearing intersection coordinates from 1 to n.
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To avoid overflow errors, LOAS uses the logarithmic method to calculate the geometric mean. The geometric
mean is a slight improvement over the arithmetic mean as it is less sensitive to bearing outliers, but it is still a
variation of the classical method of determining location of a signal. Note: The geometric mean can not be
used with negative values. Therefore, this method can not be used with some map projections that use a
central zero reference (such as Albers projection) or for simulated data sets that use an X=0, Y=0 signal
location.

Also see: Estimators

Harmonic Mean

The Harmonic Mean gives the harmonic mean average of the coordinate points using the following formula:

Equation = n / S 1 / xi. Where xi are the bearing intersection coordinates from 1 to n.

The harmonic mean is far less sensitive to outliers than either the arithmetic mean or the geometric mean, but
it is still a variation of the classical method of determining location of a signal.

Also see: Estimators

CAD Functions

About CAD

CAD (Computer Aided Design) functions are methods to change the location and shape of objects on the
canvas. All shapes visible (Points, Lines, and Polygons) may be moved or altered.

CAD functions come in two types:

 Altering existing shapes

 Adding new shapes

Add Shape

Use the Add Shape function to add point shapes to your data set with mouse clicks on the canvas.

To add points to your current dataset:

Open or create a data file for your station receivers.1.
Open any background study site coverages to use as reference.2.
Select the Telemetry Data tab to show the spreadsheet.3.
Click on the Add Shape toolbar button or select from the canvas or main menu.4.
Zoom in as needed to give good accuracy to the location placement.5.
Click on the canvas where you want the new station to be located. You will see the station location
coordinates appear under you X and Y station fields.

6.

Add any other data as necessary (azimuth measurements, etc.) by typing in the appropriate field
spreadsheet cell.

7.
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Adjust Lines

Lines and polygons consist of one or more line segments. Each line segment begins and starts at a node point.
A line or polygon shape can be altered by changing the location of any of its nodes. The shape's color or shape
styles can also be changed.

To move a node of a line, select the Pick Tool from the toolbar.1.
Place the cursor over the line that is to be altered and click on the line. The line should be highlighted
and the nodes are made visible.

2.

To move a node, place the cursor over the node. Do not press the left mouse button until the move
cursor appears (cursor has a small "o" above it).

3.

At this point press and hold down the left mouse button over the node. Then while holding the mouse
button down, move the mouse and node point to the new location.

4.

Releasing the mouse button will put the node point in its new location.5.
Click outside the line to deselect it.6.

Also see: Adjust points, Adjust polygons

Adjust Points

Point shapes can only be altered by moving their location, or changing their color or shape styles.

To move a point shape:

Select the Pick Tool from the toolbar.1.
Place the cursor over the point to move. If the cursor is positioned correctly over a point shape, the cursor
will change and a "+" sign will appear near the cursor indicating that the move cursor is active.

2.

Press and hold down the left mouse button.3.
While holding the mouse button down, move the mouse and point to the new location.4.
Releasing the mouse button will put the point in its new location. If the point shape is associated with at
data file, the corresponding spreadsheet data values for the location will also be updated.

5.

 

Also see: Adjust lines, Adjust polygons

Adjust Polygons

Lines and polygons consist of one or more line segments. Each line segment begins and starts at a node point.
A line or polygon shape can be altered by changing the location of any of its nodes. The shape's color or shape
styles can also be changed.

To move a node of a polygon, select the Pick Tool from the toolbar.1.
Place the cursor over the polygon that is to be altered and left click inside the polygon. The polygon
should be highlighted and the nodes are made visible.

2.

To move a node, place the cursor over the node. Do not press the left mouse button until the move
cursor appears (cursor has a small "o" above it).

3.

At this point press and hold down the left mouse button over the node. Then while holding the mouse
button down, move the mouse and node point to the new location.

4.

5.
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Releasing the mouse button will put the node point in its new location.5.
Click outside the polygon to deselect it.6.

Also see: Adjust points, Adjust lines

Alter Shapes

Points, lines and polygons may be changed by using the CAD Pick Tool to alter shapes.

Before a shape can be adjusted it must be selected.

First select the CAD Pick tool from the toolbar. The canvas cursor should change to correspond to the
toolbar icon.

1.

Click on the shape to be adjusted. You must click inside a polygon to select it.2.
Points and lines must only be clicked near to be selected.3.
You do not have to select the shape on the Legend. The shape you want will be inferred by the program.
If the shap can not be selected, right click on the item in the legend and select "Order > Bring To Front"
from the popup window.

4.

More specific information can be found under:

Adjust points

Adjust lines

Adjust polygons

GPS

Real Time GPS

Real Time GPS allows you to use a GPS hardware unit as a tool to determine your your current receiver
location in real time. If your GPS can output NMEA via a serial cabel (and most can) then you can use your
GPS connected to a laptop in the field to add your location as a receiver location.

If your GPS unit or computer only has a USB cable connection, then you may need to purchase a Bluetooth or
USB to Serial hardware adaptor. See the ESS Website for more information.

See GPS settings for more information how to property set up your GPS unit's interface and units.

GPS Settings

To use real time GPS you must have a GPS unit that supports the minimum hardware requirements below,
and you must properly set up the interface settings of your GPS.

Hardware requirements:
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A GPS unit that supports RMC  = Recommended Minimum Specific GPS/TRANSIT Data (also known as
$GPRMC)
A GPS with a serial port cable to attach to your computer. USB support is not currently available.
If your GPS unit or computer only has a USB cable connection, then you may need to purchase a
Bluetooth or USB to Serial hardware adaptor. See the ESS Website for more information.

GPS interface settings:

You must set up your GPS to interface using NMEA output (or input/output, but only the output is used by
LOAS).
The baud (the speed your GPS communicates with LOAS over the serial port cable) should be set to
4800.
Your base GPS map Datum should be set to WGS 84. Some GPS units do not let you adjust this setting.
Your GPS must be turned on, with active satellite connections to download location data into LOAS. Real
time GPS will not download tracklogs or waypoints stored in the GPS's memory.

Also see: LOAS GPS Window

GPS Window

To use your GPS to download real time location data, first set up your GPS as described in the GPS settings
section. Once you have done this, you may use LOAS to record your receiver location directly into your field
laptop.

To activate and use GPS data in LOAS :

1. First open a data file that will be used to store your station or receiver locations.

2. Open the GPS Real Time Data window in LOAS using either the Tools menu item (image below) or the
speed button on the toolbar.

3. In the GPS Real Time Data window, there are two settings options that you may need to change depending
on your output format requirements.

LOAS can save GPS data using either Latitude-Longitude or a UTM projection. The format you select will
change the output storage and display of the GPS data. You may select either Lat/Lon or UTM from the Output
as list box (image below).

Once you have selected an output format, you may also wish to change the Datum of this data output (see
About Projections for more information about selecting projections and datums). You may select the projection
for the GPS output data by left clicking on the Projection Parameter Settings button next to the Output as list
box
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A new Datums List window will appear allowing you to select a local datum for the recorded output (image
below). WGS 84 is the default datum used by LOAS.

4. When you are ready to start to log real time GPS data, you left click with mouse cursor on the Connect to
GPS button (image below).

LOAS will request you select the serial port where the GPS is attached and then LOAS will set up a connection
with the GPS and begin to display the current location as supplied by the GPS and your display settings.

Normally, the GPS will send location data once each second. However, if connection to the satellites are lost by
the GPS for any reason, LOAS will retain the last valid location reported and will show the time since the last
location was received (image below). You may use this information to decide to use the current location or wait
for a reconnection to the satellites by the GPS.

5. Whenever you wish to add a GPS location to your selected receiver locations data file, left click on the Add
to data layer button (image below).

Doing so will add the value shown in the Current Location box to the active receiver locations data grid. This
will also add the location to the GIS canvas. You may need to replot the data points to see them. Use the
Replot Data Points menu item under the Canvas main menu (image below).
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6. You may at any time disconnect from the GPS and stop recording location data by left clicking on the
Disconnect from GPS button (image below). Note: the is the same button you used to connect to the GPS, but
the graphic and name is changed once you connected to the GPS.

Projections

About Projections

To convert the Projection of location data one must select both a projection and a datum for both the data to
be converted and the results. Projections are selected from the "projection conversion" group located on the
lower left half of the main LOAS window. This group is also used to define projection parameters for the "to"
and "from" projections.

You may convert to and from the following:

Latitude and Longitude1.
Universal Transverse Mercator (UTM)2.
Albers (both one and two standard parallels)3.
Lambert (both one and two standard parallels)4.
Equatorial Mercator5.
Stereographic6.

Any of the conversions may also be performed between different datums.

Each location is defined along a pair of coordinate axes. The notation used to describe each axis will vary
depending on the type of location method employed. Latitude and Longitude will describe the vertical, or "Y"
axis, as Latitude, or f, and the horizontal, or "X" axis, as Longitude, or l. Other methods, for example, call the
"Y" axis the "Northing", or N, and the "X" axis the "Easting", or E. LOAS only uses the "X" and "Y" notation as a
universal description (i.e. mathematical) of the horizontal and vertical axis, respectively.

Datums

The earth is not a true sphere, but more elliptical in shape (the earth has a larger equatorial radius than a polar
radius). The Earth's surface is not perfectly smooth (mountains and valleys abound), and an irregular geoid has
been used to estimate the shape. However, for most projection conversions, this irregular shape is
unnecessary. Instead, an approximation of the Earth's surface is creating with an imaginary spheroid that has a
smooth surface.

Although the spheroid is not an exact representation of the earth's surface, it is more accurate than using a
spherical earth model. Although a spherical model is very useful when describing relative positions, and in
simplifying calculations, the spheroidal model is used by LOAS by convention.

A datum is a defining set of parameters that describe the length of this imaginary spheroid's major and minor
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axis. Different datums represent different levels of know accuracy in defining the spheroid, or are intended for
local accuracy. Older datums such as Clark 1866 are still used to define many maps of North America, such as
US Geological Survey 7.5 minute topographical quadrangles.

You may select from the following most commonly used datums:

Clark 1866, also know as the North American Datum (NAD) 19271.
International Union of Geodesy and Geophysics (I.U.G.G.) 19672.
World Geodetic Standard (WGS) 19723.
I.U.G.G 19754.
WGS 19845.

The WGS 1984 spheroid is the best global estimate of the earth commonly used today.

To change a projection from one datum to another, select the same projection in the "to" and "from" lists and
select different datums in the "Old Datum" and "New Datum" lists. The "Old Datum" is the datum used to
describe the current data. The results will be converted into values descriptive of the "New Datum" parameters.

To change both projections and datums at once, select the appropriate projections and datums.

Albers Projection

The Albers Projection is an equal area projection. If you wish to maintain local shape, you may want to use a
conformal projection.

The Albers projection is most useful at the low and mid latitudes, and is best when applied to only a local area
of the Earth. Distortion from the Albers projection is a function of latitude.

The Albers projection may be calculated as either a one or two standard parallel case. Two standard parallels
will produce less North and South distortion, but a single parallel is quite satisfactory for local areas. Standard
parallel 1 should be a Latitude that is less in absolute value than standard parallel 2. Negative standard
parallels are allowed for the Southern Hemisphere. If you wish to use a single standard parallel, uncheck the
"Use two parallels" check box. Standard parallel 1 will become the single standard parallel used.

The central meridian, in longitude, is usually centered in the area of conversion, but is up to the discretion of the
user.

Lambert Conformal

The Lambert Projection, like the Equatorial Mercator and Polar Stereographic projections, is a conformal
projections. These three projections, when used together, can map the entire earth, from the equator to the
poles.

The Lambert projection is most useful at the mid latitudes. Distortion from the Lambert projection is a function
of latitude, not longitude and is most useful for areas with a wide East and West expanse. The Lambert
projection will fail, computationally, at the poles and the equator, but a standard parallel set as little as 1
second from these extremes will produce similar results to either the Polar Stereographic and Equatorial
Mercator projections.

The Lambert projection may be calculated as either a one or two standard parallel case. Two standard
parallels will produce less North and South distortion, but is quite satisfactory for local areas. Standard parallel
1 should be a Latitude that is less in magnitude (i.e. -33 is less than -20) than standard parallel 2. Negative
standard parallels are allowed for the Southern Hemisphere. If you wish to use a single standard parallel,
uncheck the "Use two parallels" check box. Standard parallel 1 will become the single standard parallel used.
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The central meridian, in longitude, is usually centered in the area of conversion, but is up to the discretion of the
user.

Use the False X and False Y origins to shift your values to a user defined origin, different from the equator
(False Y = 0) or Greenwich Mean Longitude (False X = 0).

Universal Transverse Mercator

The UTM Projection was developed by the U.S. Army as a means of improving mapping and artillery
calculations. The bases for this projection is a 1000 meter square grid system laid out along zones that are,
usually, defined to be six degrees apart at the equator (but see below). The geographical locations of the earth
are projected onto this grid. Distortion is least at the mid point of a zone and increases as location coordinates
near the zone edge. The UTM system has quickly become a common low to mid latitude projection, but while it
can be extended to the poles, its accuracy tends to diminish significantly above 80 north or south latitude.

When using the UTM projection, make sure that the data is in the correct zone. For data that transverses more
than one zone, you must use a field that notes the zone for a location's coordinates. LOTE will automatically
record the proper zone if the conversion is to UTM in a field at the end of the spreadsheet. By default this field
is called "UTMZone", and the field name can not be changed within LOTE.

Access the UTM parameters by clicking on the parameters button in the Projection Conversion group once
UTM is selected from the projection list.

Note: Not all countries use a six degree zone width. Most notably are some African countries and some maps
of Australia. Smaller zone widths are, in theory, intended to decrease distortion at zone edges. If you change
the zone width from six degrees, the UTM zone will have to be adjusted accordingly. Unless you are trying to
map to a specific map, or are not sure of the zone width you should use, it is best to use the standard zone
width of six degrees.

Latitude and Longitude

Latitude and Longitude represents the basic description of geographical location. Each of the different
projections are mathematically derived from a latitude and longitude coordinate system. Although direct
conversion algorithms exist for between projections conversions, most convert to and from the latitude and
longitude system. The difficulty with the latitude and longitude system concerns the very nature of it being an
angular measure. For instance, the distance between 20 and 30 degrees longitude is different depending on
the latitude.

There is also no standard method of storing latitude and longitude location values, and storage is often
dependent on user preference. Two common methods of latitude and longitude notation are the Decimal
Degrees and Decimal Minutes storage types. LOTE also accepts latitude and longitude data as degrees,
minutes and seconds notation; referred to here as Decimal Seconds. However, whatever notation used,
latitude and longitude must be contained within one data field each. Separate fields for degrees, minutes and
seconds are not supported. See Latitude and Longitude Data Storage for instructions on how to transform your
data into the formats supported by LOTE.

Be sure your method of latitude and longitude storage matches the type selected in the latitude and longitude
parameters window (accessed by clicking on the parameters button in the Projection Conversion group).

Equatorial Mercator

The Equatorial Mercator Projection, like the Lambert and Polar Stereographic projections, is a conformal
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projection. These three projections, when used together, can map the entire earth, from the equator to the
poles.

There are many variations of the Mercator projection. Only the Equatorial Mercator and the Universal
Transverse Mercator projections are provided with this program. Distortion from the Equatorial Mercator
projection is a function of latitude, not longitude and is most useful for areas with a wide East and West
expanse at the equator. The Equatorial Mercator projection can also be calculated as a special case of the
Lambert projection.

The central meridian, in longitude, is usually centered in the area of conversion, but may also come from a
published value on the map for which you wish to match your conversions.

Polar Stereographic

The Polar Stereographic Projection, like the Mercator and Lambert projections, is a conformal projection.
These three projections, when used together, can map the entire earth, from the equator to the poles.

The Polar Stereographic projection is provided for locations near the poles. The standard parallel is normally
set to 90 degrees, but may be altered to a lower latitude. However, if you do this, then either the Oblique or the
Equatorial Stereographic will be selected and used by LOTE as its computational method. An alternative to this
would be to simply use another conformal projection. The Mercator may be used for locations near the equator
and the Lambert projection may be used for mid latitude values as well as near equatorial and near polar
locations.

Of computational interest, the Stereographic projection can be derived mathematically as a special case of the
Lambert projection.

Graphical Display Features

Colors and Symbols

The color and style of both the symbol used to represent point data on the canvas as well as the lines used to
draw bearings and error ellipses can be modified.

Changes in color and style can be made from the data file legend by clicking on the shape next to the file
name:

left click to change the color
right click to change the graphic style

Filling polygon shapes can only be done from the graphic colors and styles form.

Clear Display

Clearing the display clears the current canvas and all associated memory for calculated results. The
information for data files and coverages is not affected. Files are not removed from memory until they are
explicitly closed.
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Data Labels

To insert a label select the file that should display a label. The "Label For:" list shows the available files that
can have a label displayed.

Select the fields to use for label display from the "Available Variables" list. Whatever values are present in the
selected fields (the upper right box) will be displayed next to the point in a location depending on the selected
horizontal and vertical options. The font used to display the label will be that as shown in the example box. The
font color and type can be changed by selecting the "Font" button.

NOTE: Text does not transfer to all output formats. Shape or Data Interchange Format (dxf) output files will not
include text labels. In addition, while metafile (*.emf) will include text, the formatting and appearance of that text
will depend greatly on the software used to read the metafile. This is a problem well documented by Microsoft®
about the metafile format and it is not a "flaw" in LOAS.

Edge Buffer

The edge buffer is the percent of the graphic canvas that is used move the displayed data away from the edge
of the canvas.

Finding Distances

Finding distances is used to determint the linear distance between objects on the canvas. Dragging the
mouse over the canvas between two points, after left clicking, will give the linear distance. The distance is
displayed in the lower right corner of the LOAS main window.

Grab and Move

The grab and move tool allows for the canvas position to be slightly adjusted after a zoom operation. By left
clicking with the mouse and holding the mouse keep down, the current view of the graphic can be shifted in any
direction.

Graphic Styles

This graphic styles form is used to make changes to display graphics colors and styles. To make individual
changes to a shape's graphic styles quickly, use the built in functions on the Legend Tab.

Active shapes
Shape colors
Point shape styles
Line and polygon styles
Polygon fill

 

Once all the desired shape styles has been selected click on the "Apply" button to make the changes
permanent. Changes will only be displayed on the canvas when the "Update" button is clicked. This is to
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prevent constant and often lengthy redrawing while changing many graphic style options.

Files may also automatically have their color and line styles changed when each file is loaded by selecting the
desired option from the "on new file" button

Identify Data

Select the Identify Data toolbar button. Left click on any point shape in the canvas. The data associated with
this point will be displayed.

Zooming

Zooming allows for enlarging parts of the graphic canvas to see finer detail in an area. To zoom an area,
select the zoom tool. Click on the graphic canvas and while depressing the left mouse button, drag the mouse
to create a boundary definition. The canvas will enlarge the visible area to this defined boundary. Zooming does
not function with just a mouse click like some other programs. To zoom out, either click the zoom out button or
right click the graphic canvas and select zoom out. Zooming out will return to the last zoom view. To return the
normal view, click the default view toolbar button.

Simulations

About Simulations

The Simulations component allows you to test a variety of telemetry scenarios that might be encountered
during a study. These include the effects of bearing error, receiver (i.e. station) location, and moving signals.

To use the simulation component, assign values to the variables shown on each notebook page of the
Simulations form. For more information on any one notebook page follow one of the links below:

Bearing Parameters
Receiver Parameters
Signal Location
Moving Signal

The simulations component will generate a database file consisting of the known signal location and the
corresponding simulated receiver locations and bearing angles calculated from the values assigned to the
various error parameters.

Database output fields are as follows and can not be changed:

Field Description : Group Group variable to use in LOAS batch processing
ReceiverX : X coordinate of receiver
ReceiverY : Y coordinate of receiver
Azimuth : Simulated error bearing from receiver to signal
SignalX : X coordinate of the actual signal location
SingalY : Y coordinate of the actual signal location
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Bearing Parameters

Simulation bearing parameters are use to define the bearing error, number of bearing groups in the file to be
generated, and the name of the file to store the simulated data. Any one simulated data file can only have the
same number of bearings for a location group. The number of possible bearings are two (biangulation) to nine.

The angular error is the angle that the bearing was "off" from what it would have been if the bearing line were
to exactly intersect the signal location. The error can be sampled from either a uniform or random distribution.
To use a constant bearing error use the uniform distribution and select the same value for the maximum and
minimum value. If actual data is used to estimate the bearing error the Arithmetic Mean estimator should be
used to acquire bearing error estimates. Bearing errors will be output to the results spreadsheet page if the
bearing error option is selected for output.

The result bearing file will be stored in a text file you select. This output file can be altered to whatever name is
desired by selecting the "Save As" button. If the "Open File After Close" box is checked the user will be
prompted to open the last simulated file immediately after the simulation window is closed.

More on Simulations

Receiver Parameters

The receiver parameters define the locations of the receivers. The receivers are established around the signal
location in a clockwise manner. The angle between receivers can be sampled from either a random or uniform
distribution. To use a constant angle between receiver locations (such as for a "perfect triangulation" with angle
between receivers of 120 degrees) use the uniform distribution and select the same value for the maximum
and minimum value.

If the "Random Angular Start" box is checked the bearing will be started at a location randomly around the
signal. If the box is unchecked then the bearings will be offset from zero degrees. The latter method is most
useful to limit the receiver locations to one side of the signal such as when receiver locations can only be made
on one side of a signal (such as with species at sea being "tracked" with radio-telemetry from shore bound
stations).

The distance from the signal to the receivers can also be adjusted using the random or uniform distribution. To
use a constant distance use the uniform distribution and select the same value for the maximum and minimum
value.

More on Simulations

Signal Location

The simulation's signal location can be placed in the same location for simple testing of angular
error/distance effects (the default) or placed randomly around an area (such as within the limits of a study site)
to examine error ellipse or other estimates.

The distributions for the X and Y coordinate axis can be selected independently to allow for more complex point
patterns. Constant values for the X or Y signal location can be selected but using the uniform distribution and
select the same value for the maximum and minimum value.

More on Simulations

Moving Signals
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Possible effects of moving signals can be investigated by checking one the "Moving Signal" box. The angle of
the movement and the distance of the movement is then selected by choosing a distribution (normal or
uniform). Constant values for distance and angle of movement can be use by selecting the uniform distribution
and using the same value for the minimum and maximum.

Movements occur by displacing the signal position by a random distance and in a random direction after each
simulated bearing is determined. Therefore, if the file consists of 3 bearings the signal will be moved twice:
once after the first bearing is calculated and again after the second bearing is calculated. The location of the
signal is output in the resulting database file.

More on Simulations

Data Filters

Filter

When you Filter Data you are applying a user defined set of condition which allows you to define what data
records you wish to display and use with a particular set of data analysis. The filtering of data thus allows you to
limit the types of records to display in a GIS layer, the specific set of data to include in a specific analysis or
what parts of the whole data set to save to a file or print. Filtering thus gives you control over what data you use
within any file or set of files you may have open.

For instance, if you were given the following set of data as shown in the image below :

You could create a filter that could limit the data to just three records as shown in the following image :

For further information and step by step demonstrations on filtering continue to :

Filter Example 1 (single filter clause)1.
Filter Example 2 (multiple filter clauses)2.
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Sorting

When you Sort Data you order the data on any of the available field variables of your choice. Sorting may be
done on either a single file or linked files using either a single field or multiple fields.

Sort Example 1 (single field sort)
Sort Example 2 (multiple field sort)

 

 

 

Stratify

Stratification is used to separate a file into non-overlapping groups of equal value. If groupings should or
might contain overlapping members then use the Subset function.

There are 5 basic type of strata. The default is "null" or "no strata". If a file has strata and "no strata" is selected
then all strata will be removed. This is the same as closing all the strata files.

The remaining strata methods are:

By Record : Stratifies the data by record number. This is useful to look at sections of data that was
previously sorted on a variable.
By Variable : Stratifies the data on a variable of your choice. If the variable is a date or time variable, it is
better to use the Date or Time strata methods.
By Date/Time : Stratifies the data by date or time. The exact degree of strata width can be selected here
as either by day, week, month, or year. Use the "Increment By" value to select the number of days,
weeks, months or years in each strata. A date or time variable must be defined to use the date or time
strata features. Use the Redefine Variables button to assign a field as date or time if one was not already
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assigned.

 

The increment is used determine the bin width of the strata. If no increment is desired, then strata are created
so that each unique value in the selected field is a unique strata.

Each strata can be started at any initial value in the file. The unique field values are shown and displayed in a
drop down box. If more than one file is selected then the initial values box will display only those field values
contained in all the selected files. If no value is selected then the field is sorted and the strata is begun at the
first value in the field.

Subset

Subsets on data are used to define possible overlapping subsets of data. If the subsets are to have unique
members, then use the Stratify function instead.

To use the subsets functions on a file, the file must either be a database file, or have a database file associated
with it (such as ESRI® shape files). If the file is a text file or other type of shape list (such as MapInfo, or a DXF
file), then save the shape as a database or shape file format and reopen the file.

Data subsets are actually a group of filters applied to the data. Subsets of a file are a list of related filters that
partitions the data as desired. Subsets can contain the same shapes in different result sets. Therefore, new
shapes are created and stored for each subset file result. This can consume a lot of memory if filters are poorly
written.

New subset filters are added by the "New" button, and each subset filter is accessed by the tabs at the bottom
of the window displaying the current filter. To save or import a filter right click on the filter display memo.

Also see:

Software Registration

Registration Privacy

Registration Privacy

The registration of software neither collects or stores private information about users or their computers.
Registration uses an algorithm to condense unique information about a computer in such a manner that this
condensed value uniquly indentifies that computer (with a slight margin of error). This condensation of
information is not reversable, and as such can provide no information about the computer or its user.

When processing a registration for a licensed copy of a software, your User ID and Passwords are also part of
a uniquely calculated and condensed value identifier. As such both values are not stored in their original
format. Also, since both the User ID and Passwords are already on record with records pertaining to your
purchase, you are not supplying any new or sensitive information during registration.

 

Registering Evaluations
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Registering Software Trial Evaluations

Online registration is designed to activate the use counter for each copy of this software on any computer.
There is no limit on the number of different computers on which you may register a software evaluation for this
software. However, once the use counter has been registered on any single computer for this software, it can
not be stopped or rolled back on that computer except by those that have purchased a valid user license for
this software product.

Howerver, you do not have to register evaluations to use the software. That is, you do have the option to
evaluate software with a reduced capacity without registration. These two options are explained as follows:

No Registration: This option uses a reduced feature set software version that requires no online
registration. This option will cause various limitations in this software including the number of records that
can be displayed (no more than 20) and may also limit export options from the this software.

1.

With Registration: This option uses an online registration system that will fully enable all features of this
software. This option requires connecting to a remote server either directly from the software or by using
a web browser to activate an evaluation use counter.

2.

Registration of this software must be done online as the registration system must be activated from the
Ecological Software Solution's (ESS) main server. The process is secure and anonymous. No information is
collected, gathered or stored by the evaluation registration system. This system only access a program on the
main ESS server that provides a special numeric key that is used to start the evaluation counter.

Online registration is most easily done by using the software itself to connect directly to the Internet and the
ESS server. However, not all computers may be connected to the Internet, so you may also use a web browser
on any other computer to acquire the evaluation key necessary to activate the use counter.

In the event you do not have any access to the Internet, then the reduced feature option may be used as this
does not require any Internet access.

 

Direct From Software

Registration Directly From The Software

Using the Internet is required for this software to both register software evaluations or to license your software
using the password you purchased.

The quickest and easiest way to complete way to complete a registration is do so entirely from this software's
build in registration wizard. Using the built in registration wizard to complete your registration does require that
the computer on which this software is installed can connect directly to the Internet. If this is not possible, you
may need to use a web browser on another computer to complete your registration. If you are only evaluating
this software, you may also select to avoid any and all registration and accept using a reduced feature set
version of this software instead.

In either case, if you wish to complete registration entirely using this software's registration wizard or by using a
web browser, you will still need to run the registration wizard to register this software on your computer. You
access the Registration Wizard within this software from the main menu item "Help -> Register (Software
Name)".
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To inform the registration system you wish to use the Registration Wizard to directly connect to the Internet and
to use this wizard to complete your registration, select on the "Registration Method" page of the wizard the first
option as shown in the image below. Then proceed with the wizard to complete your registration.

Using a Browser

Registration With a Browser

You may register this software either directly using this software's built in registration wizard to connect to the
Internet or you may use a web browser.

You may access the online registration system in a web browser by clicking on the link below:
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http://www.ecostats.com/software/swkey.htm

If you elect to use a web browser to complete your registration, you may use a web browser on any other
computer of your choice. The browser does not need to be on a computer that has this software installed. For
example, if you are in the field you may phone someone else that has access to the Internet and that person
can provide to you the required registration key supplied by the web browser based registration system.

Even if you wish to register using a web browser you will need to complete the registration on your computer
using this software's Registration Wizard. You access the Registration Wizard within this software from the
main menu item "Help -> Register (Software Name)". To inform the registration system you wish to use a web
browser to complete your registration select on the "Registration Method" page of the wizard the second option;
that you wish to register using a web browser as shown in the image below:

 

When you log into the online registration system in your web browser, you will be required to enter your System
ID into the web browser form in the location as shown below.

After you have been provided your Key from the web browser registration system, you should enter it in the
space provided next to "Key" on the "Get Key Online" page of the Registration Wizard, then proceed to
complete your registration.
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Firewalls

Firewalls

If you have an active firewall on your computer or use a proxy to communicate with the Internet you may not be
able to use the built in registration wizard to register your copy of this software. In this case, either include in
your firewall software this software as on of those that are allowed to access the Internet or use a web browser
to register this software.

LAN Networks

LAN Network Registration

Installing software on a server and accessing that software on workstations is permitted, but this requires
certain license expectations. The standard user license is a screen or seat licenses. That is, the license is either
for the sole use of a single user on up to three different computers (e.g. home, office, laptop) or for a single
computer with multiple users registered on that one computer and accessing that computer from one screen or
seat. That is, the multiple user license is specifically where physical presence on that computer by the user is
required and this does not include server installations where users access the server from different
workstations.

Accessing software on a LAN is permitted by either purchasing a unique user registration license for each user
that will access the software on the server or by purchasing a site license. If you are interested in purchasing a
site license, send an e-mail to mail@ecostats.com for more information.
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Unregister Software

Unregister Software

You may at any time select to unregister this software from its current computer and reinstall on another
computer.

The online registration system keeps track of your registrations. You are allowed with a single user license to
install this software on up to three computers you own or on which you are the primary user. If at any time you
need to transfer the use of this software to a fourth computer, you may with a few mouse clicks unregister this
software on one of your computers and then register it on a fourth computer of your choice. That is, the total
number of registrations can not exceed three at any one time, but you move this software between any three
computers of your choice.

If you can access the internet from the computer on which this software is installed you may unregister this
software directly from the main menu item "Help -> Register (Software Name)". You may notice this is the
same menu item used to register software. If your software is not registered you will see the Registration
Wizard. If, however, your software is registered with a valid user ID and password you will be informed that the
software is registered and asked if you want to unregister this software with a message box similar to the one in
the image below:

If you would like to unregister this software, and you can connect to the Internet from this computer, select
"Yes". Else select "No. You may use this direct method of unregistering a software as frequently as you wish.

If you would like to unregister this software, and you can not connect to the Internet or if your system
experienced an error that prevents you from unregistering the software directly, you may unregister your
software by going to the web page below with a web browser:

http://www.ecostats.com/software/swkey.htm

Once you have opened the above page, select the software you wish to uninstall, fill in your user ID, password
and system ID. Then select the option to "Unregister Software" then click on the Submit button. Note: You
may only use the online system a few weeks after registering this software on a computer. This differs
from the direct method above that has no such restriction.
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